Workshop 7B Protein Isolation and Purification

Part I--Fractionation and dialysis

Introduction .......................................................... 2
Concentration and partial fractionation of a protein “extract” 3
Ammonium sulfate table ........................................... 5
Dialysis ......................................................................... 6
References and useful books ......................................... 7

Part II--Liquid Chromatography and MALDI Mass Analysis

Introduction .......................................................... 8
Size exclusion chromatography .................................. 10
Desalting using gel filtration chromatography ........... 10
Normal phase chromatography .................................. 11
Ion-exchange chromatography .................................. 12
Reversed-phase chromatography ............................... 12
HPLC instructions ..................................................... 14
MALDI instructions .................................................... 17
Principle of MALDI ...................................................... 21
MALDI sample preparation ...................................... 23
Mass Spectrometry Terms ......................................... 24
Resolution ....................................................................... 24
Mass accuracy ............................................................ 26
Common matrices used for MALDI ......................... 27
MALDI spectrums ....................................................... 29
References and useful books ....................................... 32

Equipment List .......................................................... 33
Workshop 7B- Protein Isolation and purification

Part I- Fractionation and dialysis


Introduction
The first step in protein purification involves a cell disruption step. The method of choice depends on the type of cell. In general, animal cells are easier to disrupt than bacteria, yeast or plant cells. The table below summarizes some of the methods. This list is by no means complete, as there are as many methods of disruption as there are types of cells.

<table>
<thead>
<tr>
<th>Cell Type</th>
<th>Method</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bacteria</td>
<td>French press</td>
<td>Shearing forces disrupt cell wall as the cells are forced through a small opening under very high pressure. Not practical for large volumes.</td>
</tr>
<tr>
<td>Plant cells</td>
<td>French press</td>
<td>Shearing forces disrupt cell wall as the cells are forced through a small opening under very high pressure. Not practical for large volumes.</td>
</tr>
<tr>
<td>Bacteria</td>
<td>Sonication</td>
<td>Disruption of cell walls by shearing and cavitation.</td>
</tr>
<tr>
<td>Bacteria</td>
<td>Bead Mill</td>
<td>Cell wall sheared through abrasion with glass beads.</td>
</tr>
<tr>
<td>Animal Cells</td>
<td>Blender</td>
<td>Homogenization of tissue or cells will disrupt cell walls.</td>
</tr>
<tr>
<td>Plant Cells</td>
<td>Blender</td>
<td>Glass beads (100-200 µm) are used to disrupt some bacteria, plant cells and bacterial and fungal spores.</td>
</tr>
<tr>
<td>Bacteria</td>
<td>Blender</td>
<td>Glass beads (100-200 µm) are used to disrupt some bacteria, plant cells and bacterial and fungal spores.</td>
</tr>
<tr>
<td>Bacteria Spores</td>
<td>Lysis</td>
<td>Solubilization of cell membranes by treatment with lysozyme and EDTA; Gram-positive bacteria are more susceptible than Gram-negative bacteria.</td>
</tr>
<tr>
<td>Bacteria Yeasts</td>
<td>Lysis</td>
<td>Solubilization of cell membranes with an organic solvent such as toluene.</td>
</tr>
</tbody>
</table>


Once an appropriate method has been selected, the cells or tissues are suspended in an appropriate buffer with or without reducing agents, such as β-mercaptoethanol (20-30 mM) or
dithiothreitol (2-5 mM). After disruption is complete, the suspension is centrifuged at low speed (4,000-5,000 x g) to separate cell debris from the extracted and solubilized proteins. If a membrane preparation is desired, then the supernatant of the 4,000 x g centrifugation step is centrifuged at 30,000-100,000 x g, (the speed is dependent on the source of the cells). Membrane proteins can be extracted with various ionic or nonionic detergents (Deutscher).

Concentration and partial fractionation of a protein “extract”--The salting-out technique of protein purification is mainly dependent on the hydrophobic character of the protein. The salt is dissolved into the solution containing the protein. Water will solvate the added salt ions, decreasing the solvation of the protein itself. This decrease in solvation exposes the hydrophobic regions of the protein, which then interact with each other to form aggregates that will precipitate. In general, higher molecular weight proteins will precipitate out at lower salt concentrations. For this laboratory experiment, we will use ammonium sulfate. The optimum concentration of ammonium sulfate required to precipitate the protein of interest is determined by adding increasing amounts of the ammonium sulfate and saving the precipitate for further analysis. A table is included in this handout for preparing protein solutions of different concentrations of ammonium sulfate. A disadvantage of this method is the high amount of salt that must be removed from the precipitate. To remove the salt from the protein sample, we will use both dialysis and gel filtration chromatography.

Sample: Bovine serum albumin and lysozyme in water  
Procedure: Ammonium sulfate precipitation

1. Pipet 3.0 mL of protein solution into a 50 mL centrifuge tube labeled 0-50 (be sure to put your name on the tube as well).

2. Weigh out the required amount of ammonium sulfate for 50% saturation at 0°C (see table). The initial concentration of ammonium sulfate is 0%.
   NOTE: The table uses grams/liter. Calculate the amount of ammonium sulfate needed for 3.0 mL of protein solution.

3. Add 1/3 of the ammonium sulfate to the 50 mL centrifuge tube, swirl the tube and allow to dissolve. Repeat with the remaining portions of ammonium sulfate.

4. Place the centrifuge tube on ice for 15 minutes.

5. Balance your tube with another student’s tube. Centrifuge for 10 minutes at 10,000 x gravity. Remember the position your tube was placed in the rotor.

6. Label a 15 mL tube “50-70”. Decant the supernatant from the 50 mL centrifuge tube into the 15 mL tube marked 50-70. Measure the volume of the 50-70 supernatant in the 15 mL tube and save for step 7. Dissolve the white precipitate (in centrifuge tube) in 1.0 mL of distilled water and transfer this to a microcentrifuge tube marked “Dialysis”.

7. Transfer the supernatant from the 15 mL tube labeled 50-70 into the 50 mL centrifuge tube.
8. Weigh out the required amount of ammonium sulfate for 70% saturation at 0°C (see table). Remember the initial concentration of ammonium sulfate is 50%.

9. Add 1/3 of the ammonium sulfate to the 50 mL centrifuge tube, swirl the tube and allow to dissolve. Repeat with the remaining portions of ammonium sulfate.

10. Repeat steps 4 and 5.

11. Decant the supernatant from the 50 mL centrifuge tube. Discard the supernatant into the waste container. Save the white precipitate for desalting on a column (done in the next lab period).
## Final Concentration of Ammonium Sulfate: Percentage Saturation at 0°

<table>
<thead>
<tr>
<th>Initial concentration of ammonium sulfate</th>
<th>Percentage saturation at 0°</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>20</td>
</tr>
<tr>
<td>0</td>
<td>106</td>
</tr>
<tr>
<td>5</td>
<td>79</td>
</tr>
<tr>
<td>10</td>
<td>53</td>
</tr>
<tr>
<td>15</td>
<td>26</td>
</tr>
<tr>
<td>20</td>
<td>0</td>
</tr>
<tr>
<td>25</td>
<td>0</td>
</tr>
<tr>
<td>30</td>
<td>0</td>
</tr>
<tr>
<td>35</td>
<td>0</td>
</tr>
<tr>
<td>40</td>
<td>0</td>
</tr>
<tr>
<td>45</td>
<td>0</td>
</tr>
<tr>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>55</td>
<td>0</td>
</tr>
<tr>
<td>60</td>
<td>0</td>
</tr>
<tr>
<td>65</td>
<td>0</td>
</tr>
<tr>
<td>70</td>
<td>0</td>
</tr>
<tr>
<td>75</td>
<td>0</td>
</tr>
<tr>
<td>80</td>
<td>0</td>
</tr>
<tr>
<td>85</td>
<td>0</td>
</tr>
<tr>
<td>90</td>
<td>0</td>
</tr>
<tr>
<td>95</td>
<td>0</td>
</tr>
<tr>
<td>100</td>
<td></td>
</tr>
</tbody>
</table>

Dialysis--Dialysis is a procedure to separate smaller molecules (e.g., salt) from larger molecules (e.g., protein) by using a semipermeable membrane that allows the passage of the smaller molecules but not the larger molecules. In this lab we will use dialysis tubing that does not allow the passage of molecules exceeding 12,000 to 14,000 dalton in molecular weight. After 4-6 hours of dialysis, equilibrium is achieved, at which point the concentration of the dialyzable material (salt) is the same on the inside and outside of the dialysis bag. If the volume outside the bag is much larger than the volume inside the bag, there will be a substantial decrease in the salt concentration within the dialysis bag. If the outside solution is changed several times during the dialysis (normally morning, noon and night), an even greater decrease in the salt concentration can be achieved.

**Procedure:** Dialysis of the 0-50 ammonium sulfate precipitate

1. Soak a 20 cm x 1 cm piece of hydrated dialysis tubing in distilled water for five minutes. Tie a single knot at one end. Transfer the protein solution from the microcentrifuge tube marked “Dialysis” into the dialysis tubing with a plastic transfer pipette. Be sure to keep the tubing with the knotted end down.

2. Remove air above the solution in the tubing by running the tubing between your thumb and index finger.

3. Tie a second knot in the dialysis tubing above the solution allowing some head space (but no air) for the influx of water into the tube during the dialysis. Place the tube in a 1 L beaker containing the appropriate buffer (in this case water) and a stirring bar. Place the beaker on a magnetic stirring plate. Stir the solution at a high enough speed to ensure proper circulation of the water. Dialyze at 5°C.

4. Change the dialysis fluid morning, noon and night until the dialysis fluid tests negative for sulfate with a drop of barium chloride. The barium cation reacts with the sulfate anion to form an insoluble white precipitate. If a precipitate is formed, the dialysis fluid needs to be changed. Use 1.0 mL of dialysis fluid and 1 drop of saturated barium chloride. **NOTE:** The dialysed sample will be used for HPLC in the next lab period.
References and useful books:


Workshop 7B- Protein Isolation and purification

Part II- Liquid Chromatography


Introduction—High-performance-liquid chromatography (HPLC) is at present the most common technique used to purify and characterize peptides and proteins. Used in conjunction with gel electrophoresis, it offers to the protein chemist an extremely powerful tool that has enabled the design of purification protocols unrealized before its advent. It is now possible to purify and characterize minute amounts of protein and peptides from a vast array of starting material from contaminating material. The general proliferation of HPLC-based techniques can be directly related to such attributes as sensitivity, speed, cost, and convenience.

Chromatography is a method of separating chemical mixtures into individual components. It is a separation technique, not an identification technique. In contrast, spectrophotometry can identify the presence of specific molecules in a sample mixture, but its ability to provide accurate quantitative information is limited when the sample mixture is composed of components of similar chemical structure, as it cannot separate the components. For this reason, liquid chromatography is very often coupled with spectrophotometry including ultraviolet and visible absorption, laser excitation and fluorescence methods. For example, chromatography provides the most practical method of identifying and quantifying the individual B vitamins from a multi-vitamin tablet. The same situation applies in the analysis of polymers and many other types of organic compounds.

The components of a liquid chromatography system are shown in the figure below.

Block diagram showing the components of an HPLC instrument
With liquid chromatography the sample mixture to be analyzed is dissolved in a suitable solvent (ideally this solvent is identical to the mobile phase) and introduced, by means of an injection device, onto the head of the column. The sample is then carried through the column by a continuous flow of mobile phase from the pump.

Some components of the sample will travel through the column more slowly than others. Those components that are more attracted to the column packing material are thus separated by the time they emerge, or elute, from the column end. Typically, an ultraviolet absorbance or refractive index detector monitors the components as they emerge from the column through a beam of light located at the end of the column. The detector transmits signals to a recording device that typically plots the data on a chart. This chromatogram may provide both qualitative and quantitative information about the sample.

Liquid chromatography is an innovation of analytical chemistry for both chemists and biologists. Below is a list of some of the application areas where liquid chromatography is a vital analytical technique.

**Applications Areas**
1. Pharmaceuticals
   - Research & Quality Control
2. Clinical
   - Drug monitoring, Disease Markers
3. Forensics
4. Pesticides
   - Research & Quality Control
   - Environmental Analysis
5. Biochemical Research
6. Food & Beverage
7. Polymer/Plastics

There are four major modes of liquid chromatographic separation:
- Size exclusion chromatography
- Normal phase chromatography
- Ion-exchange chromatography
- Reversed phase chromatography
Size Exclusion Chromatography--Size exclusion chromatography (SEC) is a general term that includes both GPC (Gel Permeation Chromatography) and GFC (Gel Filtration Chromatography). GPC is considered organic-based SEC and GFC is aqueous-based SEC.

SEC presents the simplest separation mechanism in chromatography. Optimally there is no adsorption involved, and the mobile phase should be considered as a carrier phase, not one which has a large effect on the chromatography. Molecules are actually separated on the basis of molecular size in solution. This is achieved with a porous packing material which is compatible with the mobile phase. The smallest components in the sample migrate into the smallest pores of the packing while the molecular dimensions of the higher-molecular-weight components prevent them from penetrating as far into the pores. Therefore the largest molecules will elute first and the smallest molecules will elute last.

SEC is more susceptible to flow than any other chromatography. This is due to 1) HETP (Height equivalent to a theoretical plate) will increase rapidly with flow. 2) High flow rates simply push the molecules through the column, not allowing complete permeation of the pore volumes. 3) Calibrations and subsequent calculations are based on flow; reproducible, accurate flow is crucial for accurate results.

Gel Filtration Chromatography

Procedure: Desalting of the 50-70 ammonium sulfate precipitate using gel filtration chromatography

1. Dissolve the second ammonium sulfate precipitation (50-70) in 1.0 mL of distilled water.
   NOTE: The volume of the solution should not be greater than 10% of the column volume.

2. Wash the column with 1 column volume of water by pouring 10.0 mL of distilled water into the top of the column and letting the water run through the column until the water level reaches the mark on the column. DO NOT let the column run dry. The level of liquid should be kept above the mark on the column during this experiment.

3. Number 15 glass culture tubes from 1 to 15 and mark them with your initials. Transfer 1.0 mL of water into a tube and place a mark at the level of the water. Place a mark at the same level on the other 14 tubes.

4. Load 0.5 mL of the 50-70 ammonium sulfate solution onto the column using a transfer pipette. Allow the solution to drain to the mark on the column while collecting the effluent into tube 1 at the same time. Add 1 mL of water to the column and collect the effluent into tube 1 and tube 2.

5. After the sample has drained to the column mark and you have collected the effluent, add 15.0 mL of distilled water to the column and collect 1.0 mL of effluent into each glass culture tube (numbered 2-15) sequentially. You will know that 1.0 mL is in the tube when the level reaches the mark you placed on the tube in step 3.
6. Add 10.0 mL of distilled water to the column to re-equilibrate it.

7. Read the absorbance of the effluent in each tube (1-15) on the spectrophotometer.

Instructions for use of the spectrophotometer:

Simple Reads Function

a. Click on the Simple Reads icon on the desktop.

b. Select Set-up, change Read at Wavelength to 280, make sure that the Ave Time is set to 1.0000 and the Y-Mode is Abs. Click Ok.

c. Select Edit->Edit Report and enter your name below the instrument line.

d. Transfer your blank solution to a clean cuvette and place in the instrument. Click Zero, then Read.

e. Transfer the first solution from the glass culture tube into an empty cuvette and place in the instrument.

f. Click Read.

g. Transfer the solution from the cuvette back into the original glass culture tube.

h. Repeat step e. through g. for each glass tube collected from the column.

i. Print the results (File->Print).

j. Exit the Simple Reads program (File->Exit). Click Ok when asked to save the data.

8. Plot the fraction number (X) versus the absorbance (Y). You should see a rise in the absorbance indicating where the protein came off the column.

NOTE: Tubes containing protein are collected and after appropriate buffer change by dialysis are ready to be loaded on an appropriate column for further purification.

9. Add 1 drop of barium chloride to each tube and note where a white precipitate is formed. You should see white precipitation where the salt came off the column.

Normal Phase Chromatography

1. Adsorption Chromatography

This is the oldest form of liquid chromatography. The technique depends upon specific interactions of the solute with the surface of a finely divided adsorbent. The adsorbent can be silica gel (the most popular), alumina, or charcoal (rarely used). Generally, we understand that the mobile phase and the solute molecules are in competition for the active sites of the adsorbent. The adsorbent-solute interaction is the most important parameter governing the separation by adsorption chromatography. If the solute has a higher affinity for the mobile phase, the compound will not be strongly retained. If the solute has a higher affinity for the stationary phase, it will be strongly retained. In other words, the higher the polarity, the stronger the interaction; thus, the longer the retention time.
2. Bonded Normal Phase Chromatography
This is similar to silica, but the silanols are chemically bonded with a polar stationary phase. The basic mechanism is based on the partitioning of the solute between the mobile phase and the stationary phase. Very similar to extraction techniques.

Ion-Exchange Chromatography--Ion exchange separations are based upon attractive ionic forces between molecules carrying charged groups of opposite charge to the charge on the stationary phase. Separations are made between a polar mobile liquid (usually water) containing salts or small amount of alcohols, and a stationary phase containing either acidic or basic fixed sites. The separation depends upon the ionic nature of the compound (e.g. pKa), the polarizability of the molecule, the solvation shell of the molecule, and the relative attraction of the compound for the ion exchange surface. After the sorption of the charged sample, desorption is brought about by increasing the salt concentration (ionic strength) in the mobile phase or by changing the pH of the mobile phase. Both ionic strength and pH can minimize the charge (electrostatic) attraction between the sample and the stationary phase, and hence, make the mobile phase stronger.

Ion-exchange chromatography separation results when sample components move through the column at different speeds. At low ionic strengths, all components with an electrostatic attraction for the ion exchanger will be tightly held on top of the column. When the ionic strength of the mobile phase is increased by adding a salt, the salt ions compete with the adsorbed sample ions for the bonded charges on the column. As a result, some of the sample components will be partially desorbed and start moving through the column. If the salt concentration is higher, the resulting ionic strength causes a larger number of the sample components to be desorbed, and the speed of the movement down the column increases. The stronger the charge attraction of the sample to the column is, the higher the ionic strength needed to bring about desorption.

At a certain level of ionic strength, no sample components are held by the charges bonded to the column. In this case, all sample components will elute at the mobile phase volume \( V_0 \).

Somewhere in between total adsorption and total desorption one will find the optimal selectivity for a given pH value of the mobile phase. Thus to optimize retention in ion-exchange chromatography, a pH value is chosen that creates sufficient charge differences among the sample components. Then, an ionic strength is selected that competes with these charge differences so that the relative movement of each component through the column results in the desired selectivity.

Reversed Phase Chromatography--In reversed phase chromatography, the packing is nonpolar and the solvent is polar with respect to the sample. Retention is the result of the interaction of the nonpolar components of the solutes and the nonpolar stationary phase. Typical stationary phases are nonpolar hydrocarbons, waxy liquids or bonded hydrocarbons (such as C\(_{18}\), C\(_{8}\), C\(_{4}\), etc.) and the solvents are polar aqueous-organic mixtures such as methanol-water or acetonitrile-water.
The C\textsubscript{18}, C\textsubscript{8}, and phenyl bonded phases are most often used in the reverse phase mode. It has been estimated that 60-90% of all analytical LC separations are done on bonded phases in the reversed phase mode. Bonded phases made by covalently bonding a molecule onto a solid stationary phase are intended to prepare “liquid coatings” which will be permanent. Silica is a reactive substrate to which various functionalities can be attached or bonded. The functionalities most widely bonded to silica are the alkyl (C\textsubscript{18} and C\textsubscript{8}), aromatic phenyl, and cyano and amino groups.

General characteristics of reversed phase chromatography

- Broad scope which allows sample types with a wide range of polarities and molecular weights to be separated.
- General rapidity of mobile phase column equilibration during methods development and gradient regeneration.
- General ease of use.
- Applicability to separation of ionic or ionizable compounds by manipulating secondary chemical equilibrium such as ionization control and ion pairing in the aqueous mobile phase.
  - Buffering the mobile phase in the pH range from 2 to 5 with one of the common buffers, the ionization of the weak acids can be suppressed or controlled allowing them to be retained in their neutral form. Similarly weak bases can be retained in their neutral form at pH 7-7.5.
  - For strong acids and bases ionization control cannot be employed because the stability of alkyl bonded phases is diminished below pH 2 and above pH 7.5. Highly hydrophilic weak acids and bases often remain difficult to retain with ionization control. In such cases ion pair reversed phase chromatography can be used. In this method, counterions (species of opposite charge to the solutes) thereby regulate the retention. Typically alkyl amines or tetra alkyl amines are added to ion pair with acids whereas alkyl sulfates, sulfonates, or phosphates are used to ion pair with bases. The technique is an alternative to ion exchange chromatography for analysis of ionic compounds.
- The possibility of special selectivity such as structural or steric are achievable by specific mobile phase additives:
  - Metal ions are capable of binding to organic compounds in a very selective method which is used for ligand exchange chromatography. The selectivity generated in these metal ion phase systems is based in part on differences of the solute (ligand) binding strength to the metal ion. An alternate approach is the addition of various chelating agents (4-dodecylidihydroxyethylenetriamine-C\textsubscript{12}dien) in combination with a metal ion. The type and strength of the metal chelate complex-solute binding can be greatly varied depending upon the chemical environment surrounding the metal ion as determined by the chelating agent added.
HPLC instructions

1. Label a 1.5 mL microcentrifuge tube with your name and the letter “A”. Cut off the top knot from your dialysis tubing and pour the dialysed sample solution (0-50 ammonium sulfate precipitation) into the 1.5 ml microcentrifuge tube labeled “A”.

2. Label a 0.5 mL microcentrifuge tube with your name and “HPLC”. Transfer 180 µl of 45% acetonitrile/water to the 0.5 ml microcentrifuge tube labeled “HPLC”. Transfer 20 µl of solution from tube “A” into tube “HPLC”.

3. To prepare the computer system for your HPLC Run click Control -> Single Run…. A new window will come up.

The HPLC conditions we are using are stored in Method 542b-c8_lc.met.

Buffer A: 0.1% TFA/water
Buffer B: 0.08% TFA/Acetonitrile
Flow Rate: 1.0 mL/min
Wavelength: 214 nm
Column: Vydac RP C-8, 4.6 mm X 250 mm
Gradient: 60% B for 1.5 minutes
60-100% B in 2.5 minutes
100-60% B in 1 minute
60% B for 1 minute

4. If Sample ID: was not highlighted, highlight it by clicking in the field. Type your first name in the Sample ID: field. Check that the Method: is 542b-c8_lc.met and the Data path: is 542b.

5. Click the Start button to start the run. A new window will come up.
6. Watch the status line until it shows "Waiting For Trigger"

7. Move the sample injector to the LOAD position.

8. Inject 200 µL of 40% acetonitrile using the 250 µL microsyringe. This will wash the sample loop of the previous sample.

9. Inject 20 µL of your sample (from the tube labeled as “HPLC”). Do not remove the microsyringe from the injection port.

10. Move the injector arm to the INJECT position. Your sample will be injected into the HPLC system. A beep will be sounded by the computer system. Remove the microsyringe from the injection port.

11. The chromatogram will be shown on the computer screen
When you hear a second beep or the run time is longer than 5.6 min, click Reports -> Print-> Method Custom Report to printout the HPLC report.
MALDI Instructions
Your dialysed sample will also be analyzed by MALDI-TOF mass analysis. This is performed by loading 0.5 µL of your sample onto a sample spot, adding 0.5 µL of matrix (sinapinic acid, 10 mg/mL) to the sample on the sample spot and mixing thoroughly. After the sample/matrix mixture has dried, the sample will be loaded into the Perceptive Biosystems Voyager DE Pro MALDI-TOF mass analyzer for analysis.

Instructions for PE ABI Voyager DE Pro MALDI-TOF Mass Spectrometer

Before running your samples on the MALDI, turn on the video monitor for the CCD camera and login to the workstation. The Voyager control software will be launched and the sample plate will be loaded into the instrument by the facility staff.

1. Click the **high voltage on/off** icon in the toolbar to turn on the high voltage

2. Click **File->75k_linear.bic** to load the instrument settings

3. Adjust the laser intensity to ~2500 by moving the slider or clicking the arrows under **Manual Laser Intensity**.
4. Move to your sample position by choosing the appropriate **Active Pos** under **Manual Sample Positioning**.

5. Click the **Acquisition Start/Stop** icon in the toolbar to fire the laser (you can also use the joystick button). Obtain a good mass spectrum (signals are more than 2000 and signal/noise is >10) by adjusting laser intensity or moving the target position with the joystick. You can watch the video monitor to see where on the sample spot the laser is firing.

6. Type your sample file name in the **Filename** window.

7. Click the **Save Spectrum** icon in the toolbar.

8. Click the **Data Explorer** icon in the toolbar. The **Data Explorer** application will launch and will display the spectrum you just obtained.
9. Click Process --> Baseline correction

10. Click Process --> Noise filter --> Noise Removal. Click OK
11. Print your spectrum by choosing File->Print->Print File with Instrument Settings.

When all of the samples have been run, the facility staff will remove the plate and shutdown the Voyager instrument.
MALDI Mass Analysis

Matrix Assisted Laser Desorption/Ionization Time-of-Flight (MALDI-TOF) is a mass analysis technique that was pioneered by Professor Franz Hillenkamp and Dr. Michael Karas of the University of Münster in Germany. The Facility has a Perseptive Biosystems Voyager DE-PRO. MALDI offers a quick and easy method of mass analysis using a minimal amount of sample. The principles involved in the MALDI mass analysis can be seen in the figure below and are described following the figure.

From Finnigan MAT

**Principles of MALDI**

- The sample is dispersed in a large excess of matrix material, which will strongly absorb the incident light.
  - The matrix contains chromophore for the laser light and since the matrix is in large molar excess, it will absorb essentially all of the laser radiation
  - The matrix isolates sample molecules in a chemical environment, which enhances the probability of ionization without fragmentation
- Short pulses of laser light (N₂, 337 nm) focused on to the sample spot cause the sample and matrix to volatilize and the matrix to ionize producing:
  - Matrix neutrals (M)
  - Matrix ions (MH)+ and (M-H)-
  - Sample neutrals (A)
- Sample molecules are ionized by an energy transfer mechanism from the matrix ions.
  - (MH)+ + A → M + AH+
  - (M-H)- + A → M + (A-H)-
Time-of-flight Mass Analyzer

* The ions formed are accelerated by a high voltage supply and then allowed to drift down a flight tube where they separate according to mass

* Arrival at the end of the flight tube is detected and recorded by a high speed recording device, smaller ions reach the detector before larger ions

The time-of-flight of the ion is converted to mass using the following principles:

- An accelerating potential \( V \) will give an ion of charge \( z \) an energy of \( zV \). This can be equated to the kinetic energy of motion and the mass \( m \) and the velocity \( v \) of the ion
  \[
  zV = \frac{1}{2}mv^2
  \]
- Since velocity is length \( L \) divided by time \( t \) then
  \[
  \frac{m}{z} = \frac{2Vt^2}{L^2}
  \]
- \( V \) and \( L \) cannot be measured with sufficient accuracy but the equation can be rewritten
  \[
  \frac{m}{z} = B(t-A)^2
  \]
  where \( A \) and \( B \) are calibration constants that can be determined by calibrating to a known \( m/z \)

Mass of an ion on the Voyager DE-PRO is determined by the following method
1. Measure time-of-flight \( t \) of the ion
2. External or internal calibration is used to determine the constants \( A \) and \( B \) so the time-of-flight can be converted to mass
  \[
  \frac{m}{z} = B(t-A)^2
  \]
3. Store \( B/V \) so changes in the 20 kV voltage supply does not effect calibration

It is assumed that all ions have the same kinetic energy.
Samples are loaded onto metal plate for analysis on the instrument. A sample concentration of 1 mg/mL is ideal and usually from one to ten picomoles of sample is required for analysis. This is spotted onto the sample position on the metal strip and then 0.5 µL of matrix (usually 10 mg/mL) is applied to the sample position as well. There are many different matrices that can be used for MALDI-TOF. Some of the most common include Sinapinic Acid (SA) for protein samples, α-Cyano-4-hydroxycinnamic acid (ACH) for peptide samples, and a 9:1 mixture of 2,5-Dihydroxybenzoic acid and 2-hydroxy-5-methoxybenzoic acid (sDHB) for carbohydrate and sometimes protein samples. DNA can also be analyzed using MALDI-TOF by employing different matrices. New matrix solutions are now in development which will yield greater sensitivity and resolution.

MALDI technology has many applications in the biochemical field. It can be used to easily monitor and optimize enzymatic digests, characterize proteins, or can be used for quality control for peptide synthesis. MALDI has also been used as a method of N-terminal and C-terminal protein/peptide sequencing. There are also applications in the rapid conformation of post translational modifications and the quantitation of drugs and chelators conjugated to monoclonal antibodies.

**MALDI Sample Preparation**

MALDI samples should be free of SDS, and should not be radioactive. It is best to remove buffer salts and detergents (e.g. by dialysis) prior to analysis and to dissolve the sample in a suitable solvent (e.g. 0.1% TFA/water) which will not degrade the spectrum. If there is too much salt in a sample, the salt signal intensity is so large that it effectively suppresses out the sample signal, giving no sample spectrum. In cases where it is not possible to remove these contaminants the sample should be in a higher concentration. It may then be possible to dilute the sample to the point where the contaminants will have little effect on the spectrum. Levels of buffers and detergents which exceed the following limits will probably cause noticeable degradation of the spectrum:

<table>
<thead>
<tr>
<th>Buffer/Solute</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phosphate buffer</td>
<td>&gt;50mM</td>
</tr>
<tr>
<td>Ammonium bicarbonate</td>
<td>&gt;30mM</td>
</tr>
<tr>
<td>Tris buffer</td>
<td>&gt;100mM</td>
</tr>
<tr>
<td>Guanidine</td>
<td>&gt;1M</td>
</tr>
<tr>
<td>Detergents (e.g. Triton-X)</td>
<td>&gt;0.1%</td>
</tr>
<tr>
<td>SDS</td>
<td>&gt;0.01%</td>
</tr>
<tr>
<td>Alkali metal salts</td>
<td>&gt;1M</td>
</tr>
<tr>
<td>Glycerol</td>
<td>&gt;1%</td>
</tr>
<tr>
<td>Sodium Azide</td>
<td>&gt;1mM</td>
</tr>
</tbody>
</table>
Mass Spectrometry terms
Average mass calculated by summing the average atomic mass of the constituent elements:
H = 1.00794

Monoisotopic mass calculated by summing the most abundant isotope's atomic mass of the constituent elements—usually used with low (< 2000 Da) molecular weight compounds
H = 1.007825

Resolution
Resolution is expressed as $m/\Delta m$ and can be defined in two different ways:
- 10% valley—A pair of adjacent ion peaks at $m_1$ and $m_2$ are resolved so that a valley of 10% is observed between them, relative to the least abundant ion of the pair, $\Delta m$ is the main difference between $m_1$ and $m_2$.
- Full-width, half-maximum (FWHM)—The width of an ion at mass $m$, at 50% abundance is used to define $\Delta m$

Resolutions determined using FWHM are about twice the resolutions determined using the 10% valley method. Figure 1 shows the importance of resolution when analyzing small peptides.

Resolution (FWHM) of the Perseptive Biosystems Voyager DE-PRO

<table>
<thead>
<tr>
<th>Linear Mode</th>
<th>Analyte</th>
<th>Concentration</th>
<th>Average MW [M+H]$^+$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>≥50</td>
<td>IgG</td>
<td>1 pmol/mL</td>
<td>~150,000</td>
</tr>
<tr>
<td>≥80</td>
<td>BSA</td>
<td>5 pmol/mL</td>
<td>64431</td>
</tr>
<tr>
<td>≥1,000</td>
<td>Myoglobin</td>
<td>5 pmol/mL</td>
<td>16952.56</td>
</tr>
<tr>
<td>≥2,000</td>
<td>Angiotensin I</td>
<td>1 pmol/mL</td>
<td>1297.51</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reflector Mode</th>
<th>Analyte</th>
<th>Concentration</th>
<th>Average MW [M+H]$^+$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>≥10,000</td>
<td>bovine insulin</td>
<td>5 pmol/mL</td>
<td>5734.59</td>
</tr>
<tr>
<td>≥1,200</td>
<td>E. coli Thioredoxin</td>
<td>5 pmol/mL</td>
<td>11674.48</td>
</tr>
<tr>
<td>≥7,000</td>
<td>Angiotensin</td>
<td>2.0 pmol/mL</td>
<td>1297.51</td>
</tr>
<tr>
<td>≥7,000</td>
<td>ACTH clips</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ACTH 1-17</td>
<td>2.0 pmol/mL</td>
<td>2094.46</td>
</tr>
<tr>
<td></td>
<td>ACTH 18-39</td>
<td>1.5 pmol/mL</td>
<td>2466.72</td>
</tr>
<tr>
<td></td>
<td>ACTH 7-38</td>
<td>3.0 pmol/mL</td>
<td>3660.19</td>
</tr>
</tbody>
</table>
Figure 1: Importance of resolution when analyzing small peptides.

**FIGURE 8.4.** Resolution: The hypothetical [M+H]$^+$ molecular ion clusters for angiotensin (molecular mass, 1283) (a), reduced insulin A chain (molecular mass, 2340) (b), and reduced insulin B chain (molecular mass, 3400) (c) are shown at various resolutions. Monoisotopic mass, peak top mass, and average mass are indicated by the dark blue, gray, and light blue lines, respectively.

**FIGURE 8.5.** Resolution: The hypothetical [M+H]$^+$ molecular ion clusters for bovine insulin (molecular mass 5734) (a), and horse heart myoglobin (molecular mass 16,952) (b) are shown at various resolutions. Monoisotopic mass, peak top mass, and average mass are indicated by the dark blue, gray, and light blue lines, respectively.


**Figure 1:** Importance of resolution when analyzing small peptides.
**Mass accuracy**

Mass accuracy can be expressed as either a percentage of the measured mass or in parts-per-million (ppm). For example, mass = 2,000 Da ± 0.01% or mass = 2,000 Da ± 100 ppm. Since this is expressed as a percentage, as the mass of the analyte increases, the absolute mass error will increase as well. This is shown in the table below:

<table>
<thead>
<tr>
<th>Percent</th>
<th>ppm</th>
<th>m/z</th>
<th>Mass Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.01%</td>
<td>100</td>
<td>1,000 Da</td>
<td>0.1 Da</td>
</tr>
<tr>
<td>0.01%</td>
<td>100</td>
<td>5,000 Da</td>
<td>0.5 Da</td>
</tr>
<tr>
<td>0.01%</td>
<td>100</td>
<td>50,000 Da</td>
<td>5 Da</td>
</tr>
</tbody>
</table>

**Mass Accuracy on the Perseptive Biosystems Voyager DE-PRO**

<table>
<thead>
<tr>
<th>Linear Mode</th>
<th>Calibration type</th>
<th>Percent</th>
<th>ppm</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>External calibration</td>
<td>0.05%</td>
<td>500</td>
</tr>
<tr>
<td></td>
<td>Internal calibration</td>
<td>0.02%</td>
<td>200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Reflector Mode</th>
<th>Calibration type</th>
<th>Percent</th>
<th>ppm</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>External calibration</td>
<td>0.01%</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Internal calibration</td>
<td>0.002%</td>
<td>200</td>
</tr>
</tbody>
</table>
### Common matrices used for MALDI

<table>
<thead>
<tr>
<th>Matrix</th>
<th>MW (Da)</th>
<th>Application Preparation</th>
<th>Initial Velocity (m/sec)</th>
<th>Characteristic monoisotopic matrix ions (in Da)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3,5-Dimethoxy-4-hydroxy-cinnamic acid (Sinapinic Acid)</td>
<td>224.07</td>
<td>Peptides, Proteins 10 mg/mL in 70% ACN/water, 0.1% TFA</td>
<td>350</td>
<td>225.076, 224.068, 207.066, 431.134</td>
</tr>
<tr>
<td>Cyano-4-hydroxycinnamic acid (ACH)</td>
<td>189.04</td>
<td>Peptides, Proteins Saturated solution in 70% ACN/water, 0.1% TFA</td>
<td>300</td>
<td>164.047, 195.050, 172.040, 379.093, 212.032, 294.076</td>
</tr>
<tr>
<td>2,5-Dihydroxybenzoic acid (DHB)</td>
<td>154.03</td>
<td>Peptides, Carbohydrates, Small molecules 10 mg/mL in 70% ACN/water, 0.1% TFA</td>
<td>500</td>
<td>155.034, 154.027, 137.024, 273.040</td>
</tr>
<tr>
<td>Molecule</td>
<td>Formula</td>
<td>Description</td>
<td>Mass 1</td>
<td>Mass 2</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------</td>
<td>---------------------------------------------------------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>3-Hydroxypicolinic acid (3HPA)</td>
<td></td>
<td><img src="image" alt="3-Hydroxypicolinic acid (3HPA)" /></td>
<td>139.03</td>
<td>96.045</td>
</tr>
<tr>
<td>Dithranol</td>
<td></td>
<td><img src="image" alt="Dithranol" /></td>
<td>226.06</td>
<td>225.055</td>
</tr>
<tr>
<td>2,2':5',2''-Terthiophene</td>
<td></td>
<td><img src="image" alt="2,2':5',2''-Terthiophene" /></td>
<td>248.39</td>
<td>248.39</td>
</tr>
</tbody>
</table>

ACN-acetonitrile  
TFA-trifluoroacetic acid  
THF-tetrahydrofuran


Acquired: 09:28:00, January 28, 2009
calibration mixture 2
C:\VOYAGER\protein\542B\cal2_0001.dat
References and useful books:


Equipment List--Workshop 7B

A) Fraction & dialysis

1) Protein solution
   add 1g of BSA and 1g of lysozyme to 100 ml of water
2) 50 ml centrifuge tube
3) 15 ml tube
4) Am$_2$SO$_4$
5) Weighing paper
6) Dialysis tube
7) 1 liter Beaker:
8) Parafilm
9) Spatulas
10) Centrifuge, 4°C
11) Ice buckets
12) Scissors

   Source
   Sigma
   Nalge Company
   Corning
   Fisher Scientific
   VWR
   Spectrum Medical Industries
   Fisher Scientific
   American National Can
   Beckman
   Fisher Scientific

B) Gel filtration & UV measurement; HPLC & MALDI

1) Desalting column, equilibrated with H$_2$O
2) Glass culture tube
3) Disposable cuvette
4) Buffer B (42% ACN)
5) HPLC sample
6) Beakers
7) Graph paper
8) Saturated BaCl$_2$

   Source
   Bio-Rad
   Fisher Scientific
   Fisher Scientific
   Fisher Scientific
   Sigma
   Fisher Scientific
   Fisher Scientific
   Fisher Scientific

NOTE: The source given above is not the only source for these supplies.